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Revit Forums
Jeff Hanson
Autodesk

Learning Objectives
•
•
•
•

Learn how to use Autodesk forums more effectively.
Learn how to apply tips from the top forum solutions to your everyday work.
Discover common problems and associated solutions.
Learn how to complete BIM projects more quickly.

Description
The Revit forums are a great resource for getting quick help on a tough problem or learning new
techniques and ways you can use Revit software tools to accomplish your everyday work.
Following forums regularly can take a lot of time; the day you don’t look is the day that you miss
a great tip. Never fear, we have taken the time to sort through thousands of forum posts to find
the very best ones to help you get the most out of your Revit software. In this class, we will
cover the top tips, techniques, and solutions offered up by the Revit forums over the past year.
Topics will range from that simple tip that speeds up your daily workflow to solutions to those big
problems that might take you months to resolve. In addition to the top solutions, you will get
valuable tips to help you make the Revit forums a valuable resource throughout the year.

Speaker(s)
As a Subject Matter Expert for Autodesk Revit, I create learning content for the Revit Help site
providing in-product help for Revit users worldwide. As Product Owner for Revit Learning Content I
also track various user forums and moderate comments in our help system in order understand the
users’ needs for learning content. Before joining Autodesk in 2005, I worked as an Architect in the
Minneapolis area for 8 years working on small scale commercial and multifamily housing projects.
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The Autodesk Forums
The Autodesk Forums are a place where the entire Autodesk community comes together to help
each other with problems and issues they face using software, managing users, or even general
professional questions Because of the size, breadth, and experience of Autodesk users, the
forums are a great place to share ideas and learn new things. Leveraging the “wisdom of the
crowd” to find answers to the toughest, most obscure, and specific problems.
Looking more specifically at the Revit Architecture Forum, it receives about 6,000 unique
visitors a day. Most of these visitors are there looking for answers, if that is how you are
comfortable engaging in the community that is perfectly ok. Of the 6000 visitors there are 130
new posts, 20 new topics, and 14 new solutions every day. Checking in at the forums every day
you can scan for topics and posts that are interesting to you and find the great solutions.

People who respond
One of the greatest things about the forums is the different people who respond. When a
question is asked people from around the world can see it. These people have a wide range of
experiences and can offer up many different perspectives and ideas to solve a problem.
Leveraging the wisdom and experience of this vast audience is really the strength of posting
questions to the forums. Your question is likely to be answered by someone who has faced the
exact same thing in the past.
The forums are also a place where Autodesk employees will respond. As employees we have
different reasons for reading the forums. In many cases we will offer a response when we know
the answer. You might see posts from people working in the support group, community
managers from the forums, members of the development team, or product managers. In some
cases, an employee can offer a response with insights others cannot provide. Typically, when a
post goes un-responded to for too long, an employee will step in and offer a response to a post.
94% of posts are responded to in some way, so if you post, you will get a response. The
average time to get back a response is 3-4 hours. If your issue needs an immediate response
the forums might not be the best place to get your answer quickly, so it is important to
understand this and post problems that you can stand to wait a bit of time for an answer. The
best time to post if you are expecting a quick answer is Tuesday, Wednesday, and Thursday
from 1pm-3pm (UTC). This is when the forums have the most traffic. More traffic means more
chance for someone to respond to your post and offer up a solution.
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Anatomy of a good post
When you do make a post, it is important to make it a good post so it has the best chance of
getting a solution. The first step to making a good post is to search the forums first. Perform a
search and see if a similar issue (or the exact same issue) has been posted before. This can
save you the time of posting and waiting for an answer. Your answer may already be waiting.
When you do search, take the time to click through a few of the results to just see if the issues
already posted can get you enough information to keep moving. Even if something is not exactly
the same, it might be close enough to give you ideas on how to move forward.
If you don’t find anything from your search and still need to post, try to make it as good as it can
possibly be to help anyone who might respond get to the issue quickly and find a solution. You
don’t want to have to go back and forth several times to just try and clarify your issue.
Give your post a short and descriptive title. The
easier the title is to understand the more likely
someone will click the topic for additional
information. Vague or unclear titles may be
skipped over and never opened. In the body of
the post make the summary/description as clear
and concise as possible. Stick to the important
points of what is happening and what you are
trying to do. Don’t just explain the problem without
explaining the goal or what your expectation is.
Include anything you might have already tried
troubleshooting the issue. If you think it is a
software “bug” the software version, you are using
is important to include. If the issue might be
hardware related include and hardware
specifications.
If possible include any images that represent the
problem. It is best to insert the image as part of
the post rather than attaching as a file. If inserted
anyone who might be reading the post can see
the issue in your post. Adding images as an
attachment requires reader to click, download,
and open the image file. This may prevent someone from responding or slow down the
response time.
Remember when making any kind of post to the forum, you want to always keep things
professional. People taking time to respond are taking their own time to try and help people just
for the sake of helping. There may be difference of opinion, or some frustration because your
issue can’t be solved, related to a software bug, requires a workaround, etc…Keep things
professional as you participate in forums.
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Top 10 Forum Solutions
The following are the top 10 solutions based on the number of times forum visitors have visited
these topics. The solutions in the top 10 range from things you may have happen to you once
and after you learn the solution you never need it again, but that first time the solution is just not
discoverable. Others might be those burning question that make you just wonder “WHY????”
and everyone who uses Revit has the same question.
So now on to the Top 10….

#10 Levels not showing in a view
This problem is related to the 3D extents of a level. The 3D extents must cross the projection
plane of the view for it to be seen. For example, in this image, the level is not displayed in the
section view because as you can see the 3D extents of the level do not extend in the extents of
the section view.

In Revit 2019 this problem is a bit easier to find and fix. 3D views can show the 3D extents of
the view.

One other more tricky way a level might not be visible is
because it is assigned to a scope box. To check for this, in
a view where you can see a missing level, select the level
and in the Properties Palette set the scope box assignment
to none. This may reveal the level in the view it is missing
from.
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# 9 Project Browser frozen
The Project Browser can sometimes lock up and stop responding for whatever reason. The
solution offered here is to “reset” the browser by toggling from one browser organization setting
to another setting and then back again. This will un-freeze the browser.
To change the browser organization on the View tab, click User Interface and then Browser
Organization. In the dialog select any other organization and then change it back to the original
organization using the same method.

#8 Can’t select objects
In some situations, you may find elements that are not able to be selected. There are several
reasons this might be. There are selection modes which will make it so some elements are not
selectable. This is usually to help you accomplish certain tasks, but if you are not aware or
forgotten a selection mode is on, it may be frustrating. The selection modes can be accessed
using the pulldown arrow under the Modify tool or from the lower right corner of the application
frame. Selection modes that affect elements being able to be selected are:
•
•
•
•

Links
Underlay elements
Pinned elements
A “by face” selection mode

If you find you are unable to select something check these modes first.
Elements in design options are also not selectable when not working in the design option, or
elements in the “Main Model” are not selectable when working in a design option. Check design
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options at the bottom of the application frame to see if the elements you want to select are in an
option not accessible to you.
One final way you may have un-selectable elements is when you are working with a workshared
project. There may be elements open but the editable only option on the application frame is
turned on making only elements editable to you able to be selected.

#7 QAT Not visible
This problem was occurring regularly in Revit 2016. It has been resolved in newer releases so if
working in a newer release you are unlikely to see this issue. There was an incompatibility
between Windows 10, Revit 2016, and Dynamo causing the QAT to become invisible in the
Windows frame when positioned above the ribbon.
There are 2 ways to resolve the issue if you see it. You can un-install Dynamo making the QAT
again visible. The other option is to change the position of the QAT to display below the Ribbon
You can do this by right clicking in the area of the QAT above the Ribbon and select the option
to display below the Ribbon.

#6 Nvidia GTX 1080 vs Quadro M400
This topic sees a lot of traffic. It is really a personal preference thing and argument for and
against each card. The Quadro is superior, but more expensive. In most cases the GTX will be
very similar in performance for a more value minded person. This one is best to go to the
forums and read the pros and cons of each card.

#5 The best way to learn Revit
New users probably account for most of the traffic to this solution. The solution gives a lot of
great resources to peoples favorite books, to searching YouTube, to classroom instruction. I
think really all of these are good suggestions and different people learn in different ways. Again,
on this on the best bet is to visit the solution yourself and make a decision on what works best
for you.
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#4 Can Revit save back to a previous version
Short and sweet answer on this one is NO. Revit CAN’T save back to a previous version. I
suspect this solution sees a lot of traffic from new users coming from AutoCAD where this is
possible. Revit just does not do this so if you are going to be working with other or consultants
be sure you coordinate the version of Revit that will be used. As an instructor at a community
college I also see this question from student AFTER they have upgraded a file at school and
then want to work at home. If you are an instructor of Revit, I would always address this
question before it is a problem.

#3 Export a schedule to Excel
Revit has always been able to export a schedule to a file that can be opened in Excel. There is
not a direct export to Excel file format. What Revit does, is export to a delimited TXT file which
can be opened in Excel (or other spreadsheet applications). In most cases this will be
automatically detected by Excel and the file will open as expected.
To export to the delimited TXT file, create a schedule view in Revit. Go to
File>Export>Reports>Schedule. This will export the schedule as a TXT file. In the export dialog,
you are asked what the field delimiter is. This is just asking for a character that is used to
separate values in the export, tab and coma are common delimiters. As you export note what
the delimiter is so when opening in Excel you can tell it that information in case it is not
detected.
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When opening the file in Excel, you must make sure you are in a full open dialog, browsing to
the file location. You need to change the file type dialog in the lower right corner to look for TXT
files instead of Excel files. Excel will use an import wizard to automatically detect the delimiting
character and open the file as a spreadsheet.

#2 Import Excel into Revit
Bringing an excel file into Revit is not quite as easy as getting a schedule out of Revit. There are
2 possible solutions offered both require additional software.
Option 1 is to use AutoCAD as an intermediary between Excel and Revit. You link the Excel
spreadsheet into AutoCAD and then link the AutoCAD file into Revit. Once both of these links
are in place, you can update the Excel spreadsheet, then update the link in AutoCAD, and then
update the link in Revit. While not completely automatic, it does offer a way for someone to
update something using Excel and have that update show up in Revit.
Option 2 is to use a 3rd party application that has built custom connections to allow Revit and
Excel information to be linked. In many cases, this will still require manual update of links when
information in Excel is changed.
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#1 Missing Properties Palette/Project Browser
Everyone has probably had this happen at one point or another. The problem is typically selfinflicted and happened by accident. Both the Properties Palette and the Project Browser can be
undocked and moved around to different locations or even to another screen. Both User
Interface elements can also be mistakenly closed. Each are closed using the typical “X” in the
upper right corner of a window. By habit, many of us will click this “X” to get a window out of the
way. Of course, in this case it is “closing” the Properties Palette or Project Browser UI element.
To get either one of these elements back on in Revit you use the User Interface button found on
the View tab of the Ribbon. Click the User Interface button and check the element you want to
turn back on.

Once you discover how to turn it back on and discover what caused the problem in the first
place you will probably never need to use this solution again.
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My Favorite Solutions
I look through the forum posts almost every day. I like to see the types of problems our
customers run into regularly, so I can make our learning content better. Looking at the forums
daily also teaches you about different techniques and solutions our customers have for different
problems. The things people can figure out always amazes me and I find myself learning things
about Revit from them. Following forums everyday can be an educational experience for even
the most experienced Revit user.
These are a few of my favorite solutions from the forums over the last few years.

Exterior window to floor area ratio calculation
The key to being able to calculate a window to floor area ratio is the room calculation point
which was added a few releases ago. For this to work, the window family must have this
calculation point turned on. With the room calculation point turned on, the window now “knows”
what room it is placed in. You will also need to add a parameter to the window family for the
glazing area.
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Make a window schedule and when a room calculation point is enabled for the windows you can
now add from:room and to:room fields to the schedule. In the filed selection dialog, use the pull
down to switch to select room fields. Add the room area field to the schedule.
Now the glazing ratio can be
calculated by dividing the glazing
area shared parameter by the room
area. Be sure the glazing area and
the glazing ratio are both set to
calculate totals in the schedule.

Door swing direction in schedule
To get a schedule to report hardware set and door swing, again we need to enable the room
calculation point for the door families in your model. Once you do this you will also need a
project parameter added to doors to hold the information, and a Dynamo script will handle
updating the information.
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Don’t let the Dynamo part of the solution scare you away, it is not terribly complicated to get this
working. The Dynamo script is downloaded from the solution. You will need to add the archi-lab
package to your Dynamo installation and the first time you run the script the package will update
it. After that, you can use the Dynamo player every time you need to update the door
information in the schedule.

Subtotal accuracy in schedules
Calculated totals in schedules do not always add up straight down the column, so it can look like
a math error has occurred. This has to do with the way the total is done in the background. Revit
is not actually totaling the values in the schedule it is totaling the value of the elements. In each
row of the schedule, the value is rounded. The total calculated does not use the rounded values,
it uses the actual values.
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To take this apparent error out of the schedule and have the value in the column total when
added directly, you can use and unformatted value that is not rounded by Revit and then scale
up the value and round it manually via a formula. Then move the decimal point back into
position and now total the new “calculated” row value. This will total correctly.

Room tag Width and Depth with question marks
In Revit 2017 the ability to add calculated values to tags was added. Some user created room
tags which can calculate and report the room width and depth in the tag. This is very effective
and can help speed documentation if the rooms are rectangular.
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The way the calculated value works however, the tag can run into problems with a room that is
perfectly square because of the way the calculation uses the perimeter and area of the room to
calculate the width and depth. This will cause the tag to display ? when placed in a square
room. To correct this, a formula can be used to check for a square room and calculate the
length according to this. The formula needed is this:
Room Length = ((Perimeter / 2) – sqrt((Perimeter / 2) ^ 2 – 4 * Area)) /2
Using this formula to find the room length the tag will no longer produce ? when a room is
square.

It is important to mention if you use the tag from this solution for room tags to display width and
depth of a room, the tag values will not be accurate for a non-rectangular room, so use caution.
For these cases you might want to have a separate tag where you can manually provide the
values.
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Dimension in a 3D view
Some annotation elements can be placed in a 3d view. You can place text notes, dimensions,
tags, and keynotes. You are not able to place detail lines, detail elements or filled regions. Even
without these detail elements you can create a 3D detail view to communicate your design. It is
worth noting this cannot be done in a perspective 3D view.
First set up the 3D view and
apply a section box to “cut”
the 3D view. To place
annotation in the right
position set the workplane to
the position you want to
annotate. In many cases it is
good to place a reference
plane, name it, and use this
reference plane when setting
the workplane. Using this
workflow you can control
where the annotation
elements are placed and be
sure you can dimension what
you need to dimension.
Once you have annotated the
view, consider locking the
view on the view control bar
so it is not accidentally
changed potentially making
the annotation not appear in
the correct position.

Complex Window Opening
Not every window opening is a simple straight cut through the wall from one
side to the other. You may have a canted edge, a rabbited edge for a wall that
is made up of multiple materials, or any kind of complex widow edge.
To create a condition like this you can alter the window family. Window families
start with a simple opening in the host wall where you build the geometry for the
window family. To create a complex opening, you can delete the simple
opening from the family and replace it with multiple voids to create the complex
opening you need.
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In this example the sloped sill condition of the window is created with 2 voids. One for the
straight cut that goes partially through the wall, and a void blend form to create the sloping sill
edge. The void families creating the complex opening will need to be constrained and
parameterized like other geometry of the window family.

View .rvt file without Revit
When you need to collaborate or have someone review work who is not working with Revit you
have a few options. Try one of these options to share your Revit file.
•
•
•
•
•
•

Autodesk Viewer – Upload the rvt file to a website and share with someone to review
Design Review – Free download application that can open a DWF file exported from
Revit
Revit Viewer – Open a Revit install without a license in “viewer mode”. You can do
anything you could do in Revit except save, or print if you have made any change to the
file.
Navisworks – Open rvt files directly. Navisworks Freedom can be installed for free.
Autodesk BIM 360 – Upload a rvt file to BIM 360 and invite anyone to the project to view
and comment online.
AutoCAD – Export your model to DWG. Export a 3D view or specific 2D views and open
in AutoCAD
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Transfer UI setting to another computer
Revit does not offer the same level of user interface customization as some applications, but
you are able to turn some tabs off in the interface, move palettes around, add tools to the Quick
Access Toolbar, and a few other settings. You may want to share these settings with other
computers you use, or share them as an office standard. This is possible by sharing the
UIState.dat file.
The UIState.dat file carries all the customization possible in the Revit user interface. The file can
be found at this location;
•

%appdata%\Autodesk\Revit\Autodesk Revit 20XX\enu

The version and language can be substituted in the path. Copy this file to any computer where
you want the same UI settings.
To reset an installation of Revit back to the default UI, you can delete this file completely. The
next time Revit is launched, a new default UIState.dat file will be created resetting the Revit UI.

View to read “Not to Scale”
In some cases, you might want to place a view on a sheet but in the view title you want it to read
“Not to Scale” or something similar. Revit view always have scale and the default view title
families report this scale.
On the view control bar where you see the scale of a view, you can create a “custom” scale. At
the top of the scale list is a setting for custom. Select this and then set the scale, but set the
label to read “Not to Scale”.
The other option to accomplish this is to create a new view title
family the replaces the scale label with a line of text reading
“Not to Scale”. Load this view title family into your project and
create a new viewport type that uses this view title instead of
one that reports the scale of the view.
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Overhead lines for families
In some situations you need to represent an overhead condition in a plan view. Element is
placed overhead are often not visible because of the way the view range is set up and/or the
category of the family.
One way you can get a family outside of the view range to display is place some geometry in
the view range of the view. The geometry can be a model line set to be invisible. This will get
the family effectively into the view range of the view without the need for visible geometry.

You can also nest families together to get 2 different representations in a plan and a reflected
ceiling pln. The nested geometry is shown in one plan while the model lines are shown in
another plan.
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The final way to do this is to turn on an underlay view temporarily and use the linework tool to
add overhead lines where you need to see them. Lines can be constrained to the underlay
elements so when the element moves the line will move as well.

Can’t rotate entire project
When you need to rotate a project in Revit there are a few options. On the Manage tab use the
Orientation tool to select to either rotate project North or true North on your project. Using these
options annotations will also rotate with the project to stay readable.
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If you need to rotate to better fit on a sheet, you might consider placing the view on the sheet
and then using the choice in the options bar to rotate the view on the sheet.

If these options are not going to work and you really need to rotate the model elements in your
project you can try this technique. Using the flowing procedure however only rotates model
elements so all annotations will need to be reworked and modified.
In a 3D View:
•
•
•
•
•
•
•

Select all model elements
Create a group
Convert the group to a link
Rotate the link
Bind the link
Ungroup the model elements
Remove the link
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Room’s lower offset above computation height
When adjusting rooms in section you may come across this error, “Room’s lower offset is above
the Computation Height.” This error is sometimes confusing because a room does not have a
“Computation Height” parameter so you are left wondering what the problem is or where you
can fix it.
The “Computation Height” is a setting of the Level the room is placed on, so in order to fix the
issue, you need to make a change to the Computation Height of the level, or adjust the lower
extent of the room.

Once you understand the error is related to the level, the error is much easier to deal with.

Conclusion
There you have it, my take on some of the top solutions you will find at the Autodesk Revit
forums. The great thing about the forums is there are great new solutions and tips to find there
every day. If you want to extend your software knowledge spend some time there. When you
come across that problem you just can’t seem to crack, make a post about it on the forums. You
may find someone with the exact knowledge, experience, and solution for your problem. Use
the Autodesk forums as another tool in your career development and lifelong software learning
journey. See you in the forums!
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